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ExpertCAD 2012 Release Summary 

April 2012 
Overview 
ExpertCAD 2012 is major release that includes enhancements as well as customer requested 
software modifications and corrections. This release summary briefly describes the software 
changes for this release. 
 

Installation 
ExpertCAD 2012 is the first release from AMT Software. Accordingly, the installation paths for 
program files and data files have been modified to reflect this. 
By default program files are installed under the directory indicated by the Windows environment 
variable ProgramFiles. For a typical installation on a 32-bit edition of Windows, the program files 
are installed in: 

c:\Program Files\AMT Software\ExpertCAD 2012 
On 64-bit editions of Windows the installation path is:  

c:\Program Files (x86)\AMT Software\ExpertCAD 2012  

Operating System Default Installation Path 

Windows – 32 bit C:\Program Files\AMT Software\ExpertCAD 2012 

Windows – 64 bit C:\Program Files (x86)\AMT Software\ExpertCAD 2012 

Similarly, program data files are installed where the environment variable ProgramData indicates. 
For a typical installation c:\Program Data\AMT Software\ExpertCAD on Windows Vista, Windows 
Server 2008 and Windows 7 and c:\Documents and Settings\All Users\Application Data\AMT 
Software\ExpertCAD on Windows XP. 

Operating System Program Data Path 

Windows XP C:\Documents and Settings\All Users\Application Data\AMT Software\ExpertCAD 

Windows Vista C:\Program Data\AMT Software\ExpertCAD 

2008 Server C:\Program Data\AMT Software\ExpertCAD 

Windows 7 C:\Program Data\AMT Software\ExpertCAD 

 
Automatic Migration of Data from a Previous Version 
At the conclusion of the installation process, the installation program will inspect your computer 
looking for a previous version of ExpertCAD. If any previous version of ExpertCAD is detected on 
the computer, the data files and settings for the most recent version of ExpertCAD are copied to 
the new installation path. This means that if you have customized program data files such as 
fonts or library macros, those file(s) will be copied to the new installation path for program data.  
When you start an application for the first time, any custom configuration file that from a previous 
version in your personal folder (e.g. ExpertCAD.cfg)  is copied to the new installation path, 
updated and sourced into the program.  You do not need to copy these files yourself.  
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ExpertCAD 2012 Program Group 
ExpertCAD 2012 is installed entirely separately from any previous versions of the software. It is 
not necessary to uninstall older version(s) of the software. In fact you can continue to use both 
2012 and older versions if you wish on the same computer. 

 

 This computer has ExpertCAD 2012 and earlier versions (2011 and 2010) installed on it. 

 
Licensing 
If you are using floating licenses, a new license file will be sent you via e-mail prior to or 
concurrent with the shipment of your 2012 software. Because the licensing authority has changed 
to AMT Software it is necessary for you to install the FlexNet floating license software from 
Flexera along with your new license file. The software for this installation is included on the CD 
with your ExpertCAD software.   
AMT Software has licensed both the 32-bit and 64-bit editions of FlexNet.  This means that you 
can designate a 64-bit computer as the license server. This was not possible in previous 
releases.  
If you are using node-locked licensing (USB key) you will not need to update your hardware key.  
There are no changes for node-locked licensing. 

Platform Support   
Operating System 32-bit 64-bit Revision Level 

Windows 7   All 

Windows Vista   All 

Windows Server 2008   All 

Windows XP   All 

Windows 2000   None 

Operating System Notes: 

• Parallel port dongles are supported for Windows XP 32-bit operating system only.  All 
other platforms require a USB dongle. 

• Windows 2000 is no longer a supported operating system.  The software will not 
install on a Windows 2000 operating system.  You must upgrade your computer to a 
modern version of Windows to install ExpertCAD 2012. 

• ExpertCAD 2012 is compatible with both the 32-bit and 64-bit version of Microsoft 
Windows. 
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• 32-bit and 64- bit editions of the software are provided on the installation CD.  For 64-
bit systems, you may choose to install either the 64-bit or the 32-bit edition on the first 
page of the installation program.   

 

Software Updates 
A new menu item in the Help menu will check our web site for any software updates that have 
been published since the last time you updated your software. 

 
Choosing Check for Updates runs an application program that contacts our web site and checks 
available update(s) for your software against your currently installed version.  If there is an update 
you'll be asked whether or not you wish to install it.  By providing this feature we can make it 
possible to provide you with timely updates as they become available without having to wait for 
the next release or service pack. 

Revised Help System 
The Help provided with your software has been revised and updated to use HTML format.  
Virtually all the relevant product documentation can be viewed and navigated using any internet 
browser (Internet Explorer, Chrome, Firefox, ...).  Previous versions used a compiled HTML 
format (.chm) which became problematic because the help could not be launched from newer 
versions of browsers because of security measures that have been added to those programs. 

Enhancements and Corrections 
An option has been added to the File I/O property sheet of the Tools/Options dialog to allow you 
to automatically terminate a session when it has been idle for a designated period of time: 

 
In the example above, if the application is idle for 2 hours, the program will save the design 
currently being worked on and exit.  This can be helpful for offices that use floating licenses to 
release a license for use by others.  This option is available in both ExpertCAD and ExpertCAM. 

The make-boundary command has been corrected to work properly regardless of the position of 
the geometry on the drawing.  The previous version could cause a segmentation violation.  
Crosshatching and area properties use this command to find the periphery of the boundary to use 
in the absence of a current line hence those features were prone to fail. 

The class attribute has been corrected to include all entities with the specified attribute name and 
optional value(s). 

A segmentation violation when inserting a call to a nested symbol into a drawing has been 
corrected.  Nested symbols (symbols with calls to other symbols) are allowed so long as the 
nested call doesn't reference itself. 
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The command clip has been corrected for function properly.  The previous version would cause a 
segmentation violation to occur. 

The Fit to paper option on the Print/Plot property sheet in the Tools/Options dialog has been 
corrected to function properly.   

The mold components library module has been overhauled to correct a number of issues with the 
user interface. 

The –s option for the AutoCAD to ExpertCAD translator has been corrected to force the drawing 
standard specified by this option to be use. 

Drawing standard (DIN, ANSI, ISO, …) was not being recognized when a drawing was written to 
AutoCAD format then imported back into ExpertCAD.   

When converting to AutoCAD format, the software will automatically correct for duplicate layer 
names in the ExpertCAD data file.  Duplicate layer names are allowed in ExpertCAD but illegal in 
AutoCAD.   

Importing an AutoCAD drawing with a crosshatch entity with a boundary consisting of a 180-
degree semi-circle has been corrected to correctly convert to an ExpertCAD crosshatch entity. 

DIN standard basic dimension types are not correctly interpreted when written to AutoCAD format 
then imported back into ExpertCAD.  Previous versions would not recognize that the dimensions 
were basic dimensions when importing the AutoCAD data. 

The handling of ISO characters has been revised to work properly when translated to other file 
formats (e.g. AutoCAD, IGES).  In the previous release, characters outside the ASCII range of 
characters could be misinterpreted and either omitted or incorrectly mapped to a different 
character. 

Discrete cases of mirrored crosshatch entities in AutoCAD data files were incorrectly interpreted 
when the file was imported into ExpertCAM for machining. 

The Zoom to Selection feature has been added to ExpertView. 

A “safe mode” has been added to ExpertCAD and ExpertCAM.  Using the command line switch 
/SAFE will cause the applications to ignore importing any customizations (.cfg files, library 
modules, etc) that would normally be loaded when the application is started.  This can be useful 
to determine if a customization file is the cause of a malfunction in the application. 

The Help button on the WinPlot dialog has been corrected to bring up the appropriate help 
documentation 

The ScriptLink text buffers APPDATA_PATH and COMMON_APPDATA_PATH have been 
implemented as read/write text buffers.  This allows for customers to change the path where the 
application look for their configuration files and external data files.  In previous releases, these 
were always read-only. 

The width of property sheets in tabbed dialogs was too small depending on the font used by 
Windows.  These dialogs have been corrected to size properly to accommodate different font 
sizes. 

Save dialogs have been corrected to allow files to be saved at the root level of a file system (e.g. 
C:\). 
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Resolved Software Requests 

When you report a problem or request an enhancement, our customer service representative will 
input your request into our software lifecycle management system and give you an ID number. 
Listed in the table below are the ID number and a synopsis of each record from our system that 
has been discharged for this release. 

Record ID Synopsis 
86 The crosshatch in this AutoCAD file cannot be imported into ExpertCAM for machining. 
88 The default file name supplied for Save file dialogs omits the '\' character(s). 
89 Can't translate this ExpertCAD file to PDB format. 
90 Some entities are missing when this AutoCAD file is imported into ExpertCAD 
91 Zoom to Selection feature is missing in ExpertView. 

102 Add a command line switch for "safe mode" that would start an application but not source in any 
configuration files. 

103 The examples shown in the ExpertCAD Reference Manual for use of the 'intersect' command are incorrect. 
105 The Send to Prospector menu items in the File menu do not activate even though Prospector is installed. 
112 Allow licensing of AMT software using remote desktop with a USB security key on the server. 
123 The Print/Plot property sheet doesn't update with the latest information from the plotcap file. 

143 The setting for the name of the font to use in the message area is not being saved to the configuration 
(.cfg) file. 

144 The Help button on the WinPlot dialog application does not bring up the help for WinPlot. 

146 The Import/Export page of the Tools/Options property sheet is not wide enough to allow the drop-down 
control on the right side of the dialog to be accessed. 

150 Create a log file to report the actions taken to finalize installation of the software. 

152 The 'Fit to paper' switch on the Print Plot property sheet in the Options dialog is not working properly in 
ExpertCAD. 

2887 Add a “safe mode” option to ExpertCAD and ExpertCAM to prevent customizations (.cfg files) from being 
imported during startup. 

2926 Help documentation for the software needs to be in HTML format instead of CHM to it can be opened from 
inside a web browser. 

2939 Allow the text buffer APPDATA_PATH and COMMON_APPDATA_PATH to be changed to point to a path 
other than what the Windows environment variables specify. 

2940 This ExpertCAD drawing won't translate to AutoCAD DXF format. 

2941 Selecting the area icon in the measure pop-up in ExpertCAD will cause a seg-v if the object is not the 
current line. 

2942 Add the ability for the applications to check for updates on the web, download them and install them. 
2943 The mold components database isn't working for items like socket-head cap screws in ExpertCAD. 

2944 The make-boundary command is not working correctly in ExpertCAD causing crosshatch to fail if the there 
is no current line. 

2946 The class 'attribute' is not working correctly in ExpertCAD. 
2947 The prpanel command does not work on 64-bit editions of the software. 
2948 The link for display of help on mold components point to the wrong help document. 
2949 Unnecessary file are installed as part of the mold components library when ExpertCAD is installed. 
2950 Add new commands to ScriptLink for sorting a list of items. 
2952 The command 'clip' is causing a segmentation violation in ExpertCAD. 
2951 The Help button on the WinPlot dialog does not work. 

2953 The 'Fit to paper' switch on the Print Plot property sheet in the Options dialog is not working properly in 
ExpertCAD. 

2955 This crosshatch entity isn't maintained as a crosshatch entity when written to AutoCAD format and then 
imported back into ExpertCAD. 

2956 ExpertCAD can't read this AutoCAD .dwg format drawing that was written from ExpertCAD. 

2957 The drawing standard in ExpertCAD (DIN, ANSI, ...) isn't always being maintained when the file is written in 
AutoCAD format then imported back into ExpertCAD. 
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2958 The option in ExpertCAD to explicitly state what drawing standard to use when importing an AutoCAD file is 
not working for DIN standard. 

2959 Basic dimensions for DIN standard drawings exported from ExpertCAD in AutoCAD format then imported 
back into ExpertCAD are not correct. 

2960 Upgrade floating license support to allow for the use of a 64-bit operating system as the license server. 
2961 Add an option so after a specified amount of inactivity the product will exit. 

2962 Swedish characters are not being converted correctly when written to AutoCAD format and imported back 
into ExpertCAD. 

2963 Add the AutoCAD feature ‘audit’ to audit the input file and correct errors prior to translation. 

2966 The OK, Cancel and Save buttons are missing on the color editor if the display is set to 125% on Windows 
7. 

2967 The 'pushnearest' primitive command group in ExpertCAD doesn't work correctly if a small hit radius is 
specified. 

2968 ExpertCAM is not honoring 'split moves' to break up the motion when cutter compensation is applied.  
2969 Execution of this custom macro causes the 'fit' command to fail in ExpertCAD. 

2970 Default name for output of a PDF file replaces the edit file extension with '.pdf' instead of appending '.pdf' to 
the name.  

2971 Correct memory leak when new macros or text buffers are created. 
2972 The AutoCAD to ExpertCAD translator outputs redundant text buffer definitions. 

2974 Add ScriptLink primitive command '.macro' to allow a macro definition to override a read-only macro or 
primitive command.  

2975 When using a default extension for file names, always append to the specified file instead of replacing the 
current extension.  

2976 Dimensions that don't create extension or dimension lines prevents the 'fit' command from working 
properly.  

2982 Reading this drawing into ExpertCAD causes an error message to be output when restoring the named 
layers.  

2983 Licensing error message dialog is being posted underneath the splash screen instead of as the top-most 
window.  

2984 Some installations omit component(s) that are needed to enable Check for Updates feature.  
2985 Some installations omit component(s) that are needed to enable Check for Updates feature.  
2986 Installation on a computer with a 32-bit processor running Windows 7 is failing to complete properly.  
2987 Installation on a computer with a 32-bit processor running Windows 7 is failing to complete properly.  

2988 Floating license installation omits configuration of the Windows firewall if the 'Skip' option is chosen during 
installation.  

  
 


	ExpertCAD 2012 Release Summary
	Overview
	ExpertCAD 2012 is major release that includes enhancements as well as customer requested software modifications and corrections. This release summary briefly describes the software changes for this release.
	Installation
	ExpertCAD 2012 is the first release from AMT Software. Accordingly, the installation paths for program files and data files have been modified to reflect this.
	By default program files are installed under the directory indicated by the Windows environment variable ProgramFiles. For a typical installation on a 32-bit edition of Windows, the program files are installed in:
	c:\Program Files\AMT Software\ExpertCAD 2012
	On 64-bit editions of Windows the installation path is:
	c:\Program Files (x86)\AMT Software\ExpertCAD 2012
	Similarly, program data files are installed where the environment variable ProgramData indicates. For a typical installation c:\Program Data\AMT Software\ExpertCAD on Windows Vista, Windows Server 2008 and Windows 7 and c:\Documents and Settings\All U...
	Automatic Migration of Data from a Previous Version
	At the conclusion of the installation process, the installation program will inspect your computer looking for a previous version of ExpertCAD. If any previous version of ExpertCAD is detected on the computer, the data files and settings for the most ...

	When you start an application for the first time, any custom configuration file that from a previous version in your personal folder (e.g. ExpertCAD.cfg)  is copied to the new installation path, updated and sourced into the program.  You do not need t...
	ExpertCAD 2012 Program Group

	ExpertCAD 2012 is installed entirely separately from any previous versions of the software. It is not necessary to uninstall older version(s) of the software. In fact you can continue to use both 2012 and older versions if you wish on the same computer.
	Licensing

	If you are using floating licenses, a new license file will be sent you via e-mail prior to or concurrent with the shipment of your 2012 software. Because the licensing authority has changed to AMT Software it is necessary for you to install the FlexN...
	AMT Software has licensed both the 32-bit and 64-bit editions of FlexNet.  This means that you can designate a 64-bit computer as the license server. This was not possible in previous releases.
	If you are using node-locked licensing (USB key) you will not need to update your hardware key.  There are no changes for node-locked licensing.
	Platform Support
	Software Updates
	A new menu item in the Help menu will check our web site for any software updates that have been published since the last time you updated your software.
	Choosing Check for Updates runs an application program that contacts our web site and checks available update(s) for your software against your currently installed version.  If there is an update you'll be asked whether or not you wish to install it. ...
	Revised Help System
	The Help provided with your software has been revised and updated to use HTML format.  Virtually all the relevant product documentation can be viewed and navigated using any internet browser (Internet Explorer, Chrome, Firefox, ...).  Previous version...
	Enhancements and Corrections
	An option has been added to the File I/O property sheet of the Tools/Options dialog to allow you to automatically terminate a session when it has been idle for a designated period of time:
	In the example above, if the application is idle for 2 hours, the program will save the design currently being worked on and exit.  This can be helpful for offices that use floating licenses to release a license for use by others.  This option is avai...
	The make-boundary command has been corrected to work properly regardless of the position of the geometry on the drawing.  The previous version could cause a segmentation violation.  Crosshatching and area properties use this command to find the periph...
	The class attribute has been corrected to include all entities with the specified attribute name and optional value(s).
	A segmentation violation when inserting a call to a nested symbol into a drawing has been corrected.  Nested symbols (symbols with calls to other symbols) are allowed so long as the nested call doesn't reference itself.
	The command clip has been corrected for function properly.  The previous version would cause a segmentation violation to occur.
	The Fit to paper option on the Print/Plot property sheet in the Tools/Options dialog has been corrected to function properly.
	The mold components library module has been overhauled to correct a number of issues with the user interface.
	The –s option for the AutoCAD to ExpertCAD translator has been corrected to force the drawing standard specified by this option to be use.
	Drawing standard (DIN, ANSI, ISO, …) was not being recognized when a drawing was written to AutoCAD format then imported back into ExpertCAD.
	When converting to AutoCAD format, the software will automatically correct for duplicate layer names in the ExpertCAD data file.  Duplicate layer names are allowed in ExpertCAD but illegal in AutoCAD.
	Importing an AutoCAD drawing with a crosshatch entity with a boundary consisting of a 180-degree semi-circle has been corrected to correctly convert to an ExpertCAD crosshatch entity.
	DIN standard basic dimension types are not correctly interpreted when written to AutoCAD format then imported back into ExpertCAD.  Previous versions would not recognize that the dimensions were basic dimensions when importing the AutoCAD data.
	The handling of ISO characters has been revised to work properly when translated to other file formats (e.g. AutoCAD, IGES).  In the previous release, characters outside the ASCII range of characters could be misinterpreted and either omitted or incor...
	Discrete cases of mirrored crosshatch entities in AutoCAD data files were incorrectly interpreted when the file was imported into ExpertCAM for machining.
	The Zoom to Selection feature has been added to ExpertView.
	A “safe mode” has been added to ExpertCAD and ExpertCAM.  Using the command line switch /SAFE will cause the applications to ignore importing any customizations (.cfg files, library modules, etc) that would normally be loaded when the application is s...
	The Help button on the WinPlot dialog has been corrected to bring up the appropriate help documentation
	The ScriptLink text buffers APPDATA_PATH and COMMON_APPDATA_PATH have been implemented as read/write text buffers.  This allows for customers to change the path where the application look for their configuration files and external data files.  In prev...
	The width of property sheets in tabbed dialogs was too small depending on the font used by Windows.  These dialogs have been corrected to size properly to accommodate different font sizes.
	Save dialogs have been corrected to allow files to be saved at the root level of a file system (e.g. C:\).
	Resolved Software Requests
	When you report a problem or request an enhancement, our customer service representative will input your request into our software lifecycle management system and give you an ID number. Listed in the table below are the ID number and a synopsis of eac...


